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Mp3 Audio Editor ユーザーガイド 

1. Mp3 Audio Editor について 

Mp3 Audio Editor は、Windows 用のサウンドエディタプログラムです。このソフトウェアを使用すると、

音声やその他のオーディオ録音を作成、及び編集できます。録音の一部を切り取り、コピーして貼り付

け、必要に応じて、エコー、増幅、ノイズリダクションなどの効果を追加できます。 

 

Mp3 Audio Editor は、非常に簡単で直感的に使用できるように設計されています。数分以内に、ファイ

ルを開いたり録音したりして編集できるようになります。しかし、時間をかけて他の機能を調べると、

プロのサウンドエンジニアを念頭に置いて設計された多くの強力なツールが見つかります。 

 

Mp3 Audio Editor basic は無料ですが、Mp3 Audio Editor Master's Editionへのアップグレードを検

討してください。 Master's Editionを使用すると、専門家を念頭に置いて設計された機能が設定され

ます。これらには、ファイルバッチコンバーターと自動化ツール、ブックマーク、ファイル領域、追加

のファイル形式などが含まれます。価格を表示したり、Mp3 Audio Editor Master's Editionを購入し

たりするには、www.Mp3 Audio Editor.comを参照してください。 

 

特徴 
 

 wav（複数のコーデック）、mp3、ogg、wmv、vox、gsm などを含む多くのファイル形式をサポートし

ます。 

 編集機能には、切り取り、コピー、貼り付け、削除、挿入、無音などがあります。 

 エフェクトには、増幅、正規化、イコライザー、エンベロープ、リバーブ、エコー、ノイズリダク

ション、サンプルレート変換などがあります。 

 66000〜96000Hzのサンプルレートをサポートします。（ステレオ、モノラル、8、16、32ビット） 

 CD-ROMから直接オーディオを読み込むための CD リッパーが含まれています。 

 プレーヤーには、正確な編集のためのスクラブ/キューコントロールが含まれています。 

 レコーダーは、自動開始終了、及び音声起動の録音をサポートしています。 

 

システムの必要条件 
 

 Windows 2000/Me/XP/Vista/8/8.1/10 

 少なくとも 16MBの RAM を搭載した Pentium300以上のプロセッサ搭載 

 サウンドカード 

 

 

 

 

 

http://www.mp3audioeditor.com/
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2. 一般的なオーディオの概念 
 

これは、これまでサウンドを扱ったことがない人の為の主要なオーディオコンセプトの一般的な紹介で

す。 自分を「オーディオファン」と分類している場合、又は、過去にサウンドについて学んだ経験があ

る場合は、このページをスキップできます。 

 

周波数 
 

音を分析する 1 つの方法は、音が空中を移動するときに振動する速度を調べることです。この振動が 1

秒間に発生する回数は、音の「周波数」と呼ばれ、ヘルツ（Hz）又はキロヘルツ（kHz）で測定されます。 

 

音が空気中を特定の周波数で振動する単一の波で構成されていない場合が非常に多く、様々な速度と音

量レベルで振動する複数の波が含まれていることがよくあります。Mp3 Audio Editorには、この効果を

自分で確認できるツールがいくつか含まれています。周波数のセクション（第 11 章）を参照してくだ

さい。 

 

人間の耳は、約 50Hz（毎秒 50 回の振動）から 20,000Hz（毎秒 20,000回の振動）までの範囲の音を聞く

ことができると言われています。実際には、私たちの殆どは、約 15,000Hz までしか聞こえませんが、オ

ーディオ愛好家は、20,000Hz までの音を聞くことができると主張することがよくあります。人の声の周

波数は 300Hz から 3000Hzの範囲です。 

 

ラウドネス、ボリューム、振幅、レベル、ゲイン 
 

ラウドネス、ボリューム、振幅、レベルという用語は、ほぼ同じ意味です。サウンドに与えられる音量

が大きいほど、サウンドを作成するためにより多くの電力が使用され、サウンドが大きくなります。 

 

サウンドの音量レベルを調整する場合（例えば、Mp3 Audio Editorの増幅効果を使用する場合）、「ゲイ

ン」値はレベルの増減量を示します。この値は、パーセントで表すことも、「デシベル」又は「dB」スケ

ールと呼ばれるスケールで表すこともできます。 

 

人間の耳は、非常に低いパワーから非常に高いパワーまで、驚くほど幅広い音を聞くことができます。

耳は、力に正比例するのではなく、対数的に力の違いを知覚します。ラウドネスサウンドエンジニアの

聞こえ方をより厳密に一致させるために、デシベルスケール（dB）を使用します。これがどのように機

能するかを実感できるように、サウンドの音量レベルを 6dB 下げると、振幅を 1/2 に、又はパワーを 1/4

に下げることになります。逆に、レベルが 6dB増加すると振幅が 2 倍になります。 20dBの低下は、振

幅の 1/10（又は電力の 1/100）を意味します。人が気付くラウドネス変化の最小単位は約+/- 3dB です。 
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オーディオ録音とコンピューター 
 

コンピューターにオーディオを保存して再生するために、マイクからのオーディオ信号は、サウンドカ

ードによって一連の数字にすばやく連続して変換されます。これらの数値は、時間の経過に伴う様々な

時点でのマイクの表面の圧力を表すものと考えることができます。オーディオを一連の数字に変換する

このプロセスは、「サンプリング」と呼ばれます。 

 

サンプルレート 
 

サンプルレートは、振幅が 1秒あたりの数値に変換される回数です。例えば、CD 品質の録音では、コン

ピューターは 1秒あたり 44100 の数値を保存し、それぞれが特定の時点での振幅を表します。 

 

サンプリングされたサウンドで伝送できる最大周波数は、サンプルレートのちょうど半分であることを

示すことができます。実際にはそれは少し少ないです。したがって、例えば、44100 のサンプリングレ

ートで作成された録音では、最大 20000Hzの周波数が伝送されます。 

 

サンプルレートのクイックガイド 
 

 6000 - 非常に低品質の音声 

 8000 - 電話品質の音声 

 11025 - 適度な品質の音声-例：口述 

 22050 - 高品質の音声、リーズナブルな品質の音楽-例：マルチメディア CD 

 

44100 - CD 品質 
 

48000、88200、96000、さらには 192000を含むより高いサンプルレートが使用されることもありますが、

多くのサウンドエンジニアは、（システムにもう少し冗長性を追加することを除いて）実際の可聴品質

の向上はないと指摘しています。 

 

ヒント：変換するたびに品質が少し低下するため、常に最終的に使用するサンプルレートでオーディオ

を録音して操作します。例えば、CD を作成する場合は 44100 を使用します。 

電話用の場合は、8000 を使用します。 

 

チャンネルステレオ/モノラル 
 

オーディオの複数の「チャネル」を同時に録音できます。最も一般的には、「ステレオ」録音は 2 つのチ

ャネル（左と右）であり、2 つの耳でオーディオの方向と空間を感じることができます。 

1 つのチャンネルだけで録音することを「モノラル」録音と呼びます。 
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8/16/24/32 ビット 
 

サウンドファイルを見たときに「8ビット」や「16 ビット」などの用語を見たことがあるかもしれませ

んが、それらが何を意味するのかわかりません。サンプルレートと同様に、ビット数はファイル内のサ

ウンドの品質、又は解像度の指標です。ビットが多いほど、解像度が高くなります。Mp3 Audio Editor

は、最適なオーディオ品質のために内部で 32ビットを使用します。ただし、通常は 16 ビットで十分で

す。 

 

オーディオファイルの圧縮とコーデック 
 

高品質のオーディオの問題の 1 つは、非常に大きなサイズのオーディオファイルが作成される可能性が

あることです。これを回避するために、「圧縮」と呼ばれるものを使用してファイルのサイズを小さくす

ることができます。オーディオファイルに圧縮を実装するために使用されるシステムは、「コーデック」

と呼ばれます。 

 

MPEG Layer-3/MP3、Ogg ファイル(Ogg Vorbis）、GSM（電話や音声に適しています）など、様々なコーデ

ックがあります。殆どのコーデックは、特定の機能用に設計されており、通常は音楽、又は音声のいず

れかを保存します。Ogg は同ビットレートの MP3 よりも聴感上良い音で再生でき、さらに AAC や WMA な

ど、他の非可逆圧縮の形式と比較しても引けをとらないようです。特に低ビットレートではその性能は

高く評価されています。但し、知名度や技術的要因のため Ogg対応の携帯音楽プレーヤーはまだまだ少

ないようです。 

 

Mp3 Audio Editorで「File」→「Save As option」オプションを使用するときに使用する圧縮コーデッ

クを選択できます。但し、殆どの圧縮コーデックは不可逆であることに注意してください。これは、フ

ァイルを保存するたびにオーディオ品質が失われることを意味します。このため、本当に必要になるま

でオーディオを圧縮形式で保存しないことが重要です。例えば、さらに作業を行うときにファイルを保

存する必要がある場合は、44100Hz、16ビット PCM 形式の Waveなどの非圧縮形式で保存します。 

 

オーディオファイル圧縮をオーディオダイナミックレンジ圧縮と混同しないでください。ファイル圧縮

はファイルサイズの縮小に関するものですが、ダイナミックレンジ圧縮はボリューム制御に関するもの

です。ダイナミックレンジ圧縮の詳細については、エフェクト（第 10 章）を参照してください。 

 

編集とエフェクト 
 

編集とは、音声を削除、又は挿入することを意味します。エフェクトは、オーディオを何らかの方法で

変更するプロセスです（例えば、エコーを追加したり、柔らかくしたりします）。 

Mp3 Audio Editorの編集（第 9章）及びエフェクト（第 10章）メニューを参照してください。各効果

については、効果のページ（第 10章）で詳しく説明されています。 
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3. オーディオファイルの作成、開始、保存 
 

新しいオーディオファイルの作成 
 

Mp3 Audio Editor の起動画面から Ctrl+ Nを押すことで、新しいファイルを作成することができます。 

 

Mp3 Audio Editor は通常、新しいファイルを作成するときサンプルレートとチャンネルを選択するよう

に促します。このプロンプトを無効にし、Mp3 Audio Editorオプションを使用してデフォルトのレート

を設定できます。 

 

サンプルレートとチャンネルを選択する際のガイドとなる詳細については、一般的なオーディオの概念

（第 2章）（サンプル、チャンネルなど）を参照してください。 

 

既存のオーディオファイルを開く 
 

既存のファイルを開くには、Ctrl + O を押し、参照して開きたいファイルを見つけ「Open」をクリック

します。 

 

CDからオーディオトラックを読み込むには「CDs by select File」→「Load Audio CD Track」を選択

して、CDからオーディオトラックを読み込むことができます。トラックをクリックすることで選択しま

す。 

 

オーディオファイルの保存 
 

現在のオーディオファイルを現在の名前で保存するには、Ctrl + Sを押します。 

別の名前、又は別の形式でファイルを保存するには、メニューの「File」→「Save As」（名前を付けて

保存）を使用します。 

 

注：オーディオファイルを操作する場合は、すべての編集が完了するまでファイルを圧縮形式で保存し

ないでください。圧縮形式で保存して再読み込みするたびに、品質が低下するためです。品質を維持す

るためには WAV非圧縮形式で保存します。 
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4. 再生、録音、移動、領域の選択 
 

再生 
 

現在の位置から再生するには、F9 キーを押します。 

 

録音 
 

録音(現在の位置、又は選択したリージョン上)するには、F5 キーを押します。詳細については、レコー

ド(第 7章)ページを参照してください。 

 

ファイル内の移動 
 

最初に移動するには、Home キーを押し、最後に移動するには End キーを押します。 

巻き戻すには、左矢印キーを押したままにします。早送りするには右矢印キーを押します。 

ウェーブウィンドウの 1つをクリックして位置を移動することもできます。 

 

スクラブ再生 
 

スクラブ再生とはデータの任意の場所をドラッグし再生することで、データの部分的な確認や頭出しな

どに便利な機能です。 

耳で正確な編集位置を見つけるには、スペースバーを押して scrub（スクラブ）をアクティブにします。

これにより、編集したいポイントを聴きながら、より細かい動きが可能になります。 

 

領域の選択 
 

一部のエフェクト、又は編集機能を適用する前に、エフェクトを編集、又は適用するリージョンを選択

する必要があります。 Ctrl+ A を押して、ファイル全体を選択します。 

ウェーブウィンドウをマウスでクリックして選択するには選択する部分をドラッグします。 
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5. サンプルレートとチャンネルの変換 
 

Mp3 Audio Editor は、ファイルのサンプルレート、又はチャンネル数を変換できます。この変更はファ

イル全体に適用されます。（ファイルの一部だけを変更することはできません） 

 

現在のファイルのサンプルレートを変換するには、メニューの「File」→「Convert Sample Rate and 

Channels」（サンプルレートとチャネルの変換）を使用して、新しいサンプルレートとチャネルを選択し

ます。 

 

サンプルレートは、毎秒 6000～96000サンプルである必要があります。一般的なサンプルレートがプル

ダウンリストに表示されます。サンプルレートを下げる一般的な理由は、電話で使用されることがわか

っている場合（8000 モノラル）、又は、インターネット送信用にファイルを圧縮しようとしている場合

（GSM は 11025、又は 8000モノラルを使用するなど）です。サンプルレートの概要については、一般的

なオーディオの概念（第 2 章）を参照してください。 

 

6. ステレオ機器の接続 
 

この章では、テープデッキ（カセットテーププレーヤー）、又はレコードプレーヤーをコンピューターに

接続する方法について説明します。 

 

6.1 テープデッキの接続（カセットテープ） 

 

外部テープデッキ、又はコンパクトステレオシステムを使用している場合は、以下に示すように、機器

の裏側に Line Out、Tape Out、又は Tape Recというラベルの付いたいわゆる「RCAコネクタ」が付い

ている可能性があります。 

 

 

 

 

テープデッキ、又はステレオシステムのラインアウトをコンピューターに接続する必要があります。 

 

 

 

テープデッキユニットの RCA コネクタ 

サウンドカードをライン出力コネクタ（1）に接続します。 
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通常、統合サウンドカードには、「ミニジャック」コネクタ（3.5mmジャックとも呼ばれる）が装備され

ています。 

 

 

 

ミニジャックコネクタでサウンドカードに接続 
 

コンピューターにミニジャックコネクタがある場合、テープデッキ、又はステレオシステムをコンピュ

ーターに接続するには、一方の端にミニジャックコネクタがあり、もう一方の端に RCA コネクタがある

接続ケーブル（下図）が必要です。 

 

 

 

 

サウンドカードやコンピューターでこのようなケーブルを受け取っていない場合は、通常のオーディオ

ストアや電気店で購入できます。 

テープデッキ、又はステレオシステムを接続するには、RCA コネクタの端をテープデッキ、又はステレ

オシステムの Line Out、Tape Out、又は TapeRecコネクタに接続します。 

もう一方の端をコンピューターのライン入力コネクタに接続します。 

 

 

 

 

 

 

サウンドカードとミニジャックコネクタ（1）のラインが統合されたコンピューターの背面ペイン 

一方の端に RCA コネクタがあり、もう一方の端にミニジャックコネクタがある接続ケーブル 
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RCA コネクタを使用してサウンドカード、又は USB オーディオデバイスに接続 
 

オーディオ入力、及び出力用の外部 USBデバイスの人気が高まっており、これらの多くには通常の Line 

InRCA コネクタが付いています。まれに、内部サウンドカードに RCA コネクタが付いている場合もあり

ます。このような場合、両端に RCA コネクタが付いた接続ケーブルが必要です。 

 

 

 

 

6.2 レコードプレーヤー（LP）の接続 

 

アンプがすでにセットアップされているステレオシステムを使用している場合、レコードプレーヤーを

コンピューターに接続する最も簡単な方法は、コンピューターをアンプのライン出力コネクタ（呼称：

Tape Out、Tape Rec、Rec Out）に接続することです。 

 

 

 

 

 

 

両端に RCA コネクタが付いた接続ケーブル 

アンプの RCA コネクタ 

レコードプレーヤーが PHONO IN（1）に正しく接続されていることを確認し、

サウンドカードを REC OUT コネクタ（2）に接続します。 
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6.3 アンプを介してレコードプレーヤーを接続 

 

続行する前に、レコードプレーヤーがアンプに正しく接続されていること、及びステレオシステムでレ

コードを聞くことができることを確認してください。 

アンプ、又はステレオシステムのライン出力をコンピューターに接続する必要があります。統合サウン

ドカードには通常、「ミニジャック」コネクタ（3.5 mm ジャックとも呼ばれます）が装備されています。 

 

 

 

ミニジャックコネクタでサウンドカードに接続 
 

コンピューターにミニジャックコネクタがある場合、アンプ、又はステレオシステムをコンピューター

に接続するには、一方の端にミニジャックコネクタがあり、もう一方の端に RCAコネクタがある接続ケ

ーブルが必要です。 

 

 

 

サウンドカードやコンピューターでこのようなケーブルを受け取っていない場合は、通常のオーディオ

ストアや電気店で購入できます。 

アンプ、又はステレオシステムを接続するには、RCA コネクタの端をアンプの Line Out、Tape Out、又

は TapeRecコネクタに接続します。もう一方の端をコンピューターのライン入力コネクタに接続します。 

 

 

 

 

サウンドカードとミニジャックコネクタ（1）のラインが統合されたコンピューターの背面ペイン 

一方の端に RCA コネクタがあり、もう一方の端にミニジャックコネクタがある接続ケーブル 
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RCA コネクタを使用してサウンドカード、又は USB オーディオデバイスに接続 
 

オーディオ入力、及び出力用の外部 USBデバイスの人気が高まっており、これらの多くには通常の Line 

InRCA コネクタが付いています。まれに、内部サウンドカードに RCA コネクタが付いている場合もあり

ます。このような場合、両端に RCA コネクタが付いた接続ケーブルが必要です。 

 

 

 

 

RCA 接続ケーブルをまだお持ちでない場合は、通常のオーディオ店、又は電気店で購入できます。この

場合、行わなければならないのは、アンプ、又はステレオシステムの Line Out、Tape Out、又は TapeRec

と USBオーディオデバイスの Line Inコネクタにケーブルを接続することだけです。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

両端に RCA コネクタが付いた接続ケーブル 
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6.4 レコードプレーヤーを直接接続 

 

LPレコードのオーディオは技術的な理由で変更され、低周波数（低音）が柔らかすぎ、高周波数（高音）

が大きすぎるため、通常、レコードプレーヤーをコンピューターに直接接続することはできません。 

Phono 入力を備えたアンプは、正確に調整されたイコライザーを使用して信号を変更し、元の信号が復

元されるようにします。この目的のためだけにハードウェアユニットを購入することも可能です。これ

らは通常、Phonoプリアンプと呼ばれます。 

 

幸いなことに、Mp3 Audio Editorを使用している場合は、おそらく追加のハードウェアは必要ありませ

ん。 Mp3 Audio Editor は、Phono プリアンプのイコライザーをエミュレートし、元のオーディオを復

元します。レコードプレーヤーをサウンドカードのライン入力に直接接続し、録音ページで Phono プリ

アンプのエミュレートオプションを有効にすることができます。 

 

殆どの場合、レコードプレーヤーには、下図に示すように、Phono というラベルの付いた裏面に「RCAコ

ネクタ」があります。 

 

 

 

一部のレコードプレーヤーには、オス RCAコネクタ付きの固定ケーブルが付属しています。 

 

 

 

 

 

 

 

 

レコードプレーヤーのRCAコネクタ 

オス RCAコネクタ付きケーブル 
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レコードプレーヤーからの出力をコンピューターに接続する必要があります。 

統合サウンドカードには通常、「ミニジャック」コネクタ（3.5 mm ジャックとも呼ばれます）が装備さ

れています。 

 

 

 

ミニジャックコネクタでサウンドカードに接続 
 

コンピューターにミニジャックコネクタとレコードプレーヤーのメス RCA コネクタがある場合、レコー

ドプレーヤーをコンピューターに接続するには、下図のような一方の端にミニジャックコネクタがあり、

もう一方の端に RCAコネクタがある接続ケーブルが必要です。 

 

 

 

 

サウンドカードやコンピューターでこのようなケーブルを受け取っていない場合は、通常のオーディ

オストアや電気店で購入できます。 

 

レコードプレーヤーを接続するには、RCAコネクタの端をレコードプレーヤーの Phono Outコネクタに

接続します。もう一方の端をコンピューターの Line In コネクタに接続します。 

 

 

 

 

 

サウンドカードとミニジャックコネクタ（1）のラインが統合されたコンピューターの背面ペイン 

一方の端に RCA コネクタがあり、もう一方の端にミニジャックコネクタがある接続ケーブル 
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レコードプレーヤーにオス RCA コネクタ付きの統合ケーブルがある場合は、下図のような、RCA-ミニジ

ャックアダプタ（オーディオ、又は電気店で入手可能）が必要になります。 

 

 

 

アダプタのミニジャック側は、すでに説明したように、サウンドカードの Line In コネクタに接続でき

ます。 

 

RCA コネクタを使用してサウンドカード、又は USB オーディオデバイスに接続 
 

オーディオ入力、及び出力用の外部 USBデバイスの人気が高まっており、これらの多くには通常の Line 

InRCA コネクタが付いています。まれに、内部サウンドカードに RCA コネクタが付いている場合もあり

ます。このような場合、レコードプレーヤーにオスの RCAコネクタが接続されたケーブルがない場合は、

両端に RCAコネクタが付いた接続ケーブルが必要です。 

 

 

 

 

RCA 接続ケーブルをまだお持ちでない場合は、通常のオーディオ店、又は電気店で購入できます。この

場合、行わなければならないのは、ケーブルをレコードプレーヤーの Phonoコネクタと USBオーディオ

デバイスの Line Inコネクタに接続することだけです。 

 

 

 

 

 

RCA ミニジャックアダプタ 

両端に RCA コネクタが付いた接続ケーブル 
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7. 録音のコントロール 
 

Mp3 Audio Editor でオーディオを録音するのは簡単ですが、最初の録音プロジェクトを開始する前に知

っておくべきいくつかの用語があります。 「デジタルオーディオの概念」（第 6 章を参照）では、デジ

タルオーディオに関するいくつかの重要な問題について理論的に説明しています。デジタルオーディオ

に精通している場合は、サウンドカードを使用した録音（7.2 章を参照）に進んでください。 

 

7.1 デジタルオーディオの概念 

 

コンピューターでオーディオを編集する前に、デジタル化する必要があります。テープレコーダー、マ

イク、レコードプレーヤーなどの殆どのオーディオ機器からの出力はアナログです。 

アナログとは、オーディオ信号が交流電圧で表されることを意味します。電圧は、演奏中の空気中の気

圧変化がアナログであるためアナログ信号と呼ばれます。コンピューターのサウンドカードは、絶えず

変化する電圧を一定の速度間隔で数値のストリームに変換するために必要です。このプロセスは、サン

プリングと量子化と呼ばれる 2 つのステップで実行されます。 

 

サンプリング 
連続的に変化する測定値から離散的な時間インスタンスでの一連の測定値への変換は、サンプリングと

呼ばれます。サンプリングが行われる速度（又は 1秒あたりの測定数）は、量子化の深さとともに、デ

ジタル録音装置の最も重要な品質要素です。設定が低すぎると、邪魔なアーティファクトが発生します。 

CD品質の録音は、毎秒 44～100サンプルのサンプリングレートで録音されます。サンプリング周波数は

44100 ヘルツ（又は、短い Hz）であると言います。 

 

実際、ナイキスト周波数として知られているサンプリング周波数の半分を超えるすべての周波数は、ナ

イキスト周波数より低い周波数に置き換えられます。この効果はエイリアシングと呼ばれます。 

エイリアシングを回避するために、サンプリングシステムには、ナイキスト周波数より上のすべての周

波数を理想的にフィルターで除去し、それより下のすべての周波数に影響を与えないローパスフィルタ

ーが含まれています。オーディオ CD の場合、理論的に録音できる最高周波数は 22050Hzです。 

 

量子化 
一定の時間間隔でアナログ入力信号を測定した後、サンプルのストリームがあります。サンプルは、特

定の時点で測定された電圧の観点から存在します。電圧は通常、法定電圧範囲内の無数の可能な電圧の

1 つです。コンピューターは、無限の可能性のすべてを正確に記述することはできないため、対象の電

圧範囲を固定サイズの領域に分割する必要があります。 1 つの領域内のすべての電圧には、量子化プロ

セス中に特定の数値が与えられます。離散電圧レベルの数が多いことを意味する領域が多数ある場合、

電圧レベルが少ない場合よりも正確に電圧を記述することができます。オーディオ CDは、65536 の電圧

レベルで量子化されます。これは、16 ビットの 2進数でアーカイブできるレベルの最大数です。したが

って、オーディオ CDの解像度は 16 ビットであると言えます。最近のレコーディングスタジオでは、マ

スタリングプロセス中に 24 ビット以上の解像度を頻繁に使用しています。 
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デシベル単位（dB） 
 

録音された音の音量が変化する場合、変化の程度は通常、デシベル、又は短い dBで表されます。 

これは、オーディオに関連する一般的な単位です。Mp3 Audio Editorでは、デシベルを使用して、元の

レベルに対する変化の程度を表します。 

 

デシベル単位の特別な点は、対数目盛に基づいていることです。ゼロ dBは変化がないことを表し、6dB

の増加は信号振幅の 2 倍を表します。6 dB減らすと信号振幅が半分になります。 

 

 

 

デシベルスケールは、同じ対数特性を持つ人間の耳の感度曲線に合うように選択されます。 

 

7.2 サウンドカードによる録音 

 

以下の手順に従って、レコードプレーヤー、テープデッキ、マイクなどのオーディオ機器からサウンド

カードを介してオーディオを録音してください。 

 

1. オーディオソースがコンピューターのオーディオ入力に正しく接続されていることを確認します。

オーディオ機器の接続方法の詳細については、ステレオ機器の接続（第 6 章）を参照してください。 

2. 「File」を選択して、空の録音ウィンドウを新規作成します。 

「New…」又は、録音したオーディオを挿入する場所にカーソルを置きます。 

3. 「Control」を選択します。Record．．．（録音） 

4. 空の編集ウィンドウに録音している場合 Mp3 Audio Editorは、使用するサンプル形式を知る必要

があります (詳細については、デジタルオーディオの概念（7.1章）を参照してください。 

目的の録音形式を選択し「OK」というラベルのボタンをクリックしてください。 

5. 「Recording」（録音）ダイアログボックスが開きます。ここで、コンボボックスの行で正しい入力

行が選択されていることを確認します。レベルメーターを使用して入力レベルを監視し、必要に応

じて入力レベルスライダーを使用して入力レベルを調整できます。クリッピングの歪みを避けるた

めに、レベルメーターは決して赤い領域にあってはなりません。 

6. 録音を開始するには、「Record」（録音） というラベルのボタンをクリックします。 

7. 録音が完了したら、「Keep」というラベルのボタンをクリックして、録音を受け入れます。 

 

 

 

 

 

デシベル dB 対強度変化（パーセント） 
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タイマー録音 
 

タイマー録音機能を使用すると、一定の期間後、又は入力信号の存在に応じて、録音を開始、及び停止

できます。タイマー録音を開始するには、録音ダイアログで「Timer Record」というボタンをクリック

します。 

・ 録音は手動で開始するか、特定の日時に開始するかを選択できます。 

・ 録音は一定の時間の後に自動的に停止することもできます。 

 

詳細な録音オプション 
 

Mp3 Audio Editor の録音ダイアログには、いくつかの詳細設定もあります。 

 

・ 無音無しの録音 

 

信号がアタックタイムを超えてアタックレベルを下回っている場合、オーディオのそのスポットの

始まりは無音の始まりと見なされます。 

信号がリリースタイムを超えてリリースレベルを超えている場合、オーディオのそのスポットの開

始は無音の終了と見なされます。 

 

・ 無音の定義 

 

非常に静かな高品質のオーディオの場合、アタックレベルとリリースレベルの値（-60dBなど）は低

くなります。ノイズの多いオーディオの場合、値ははるかに高くなる可能性（-30dBなど）がありま

す。 

オーディオが指定されたミリ秒数を超えてこの指定されたしきい値を超えている場合、オーディオ

は有効であると見なされ、無音ではないと見なされます。リリースタイムに高い値を使用して、短い

期間のオーディオ（クリック音、静的ノイズ、その他のノイズなど）を無視します。ただし、この値

が高すぎる場合（200ms を超える場合）は短い単語はスキップされる可能性があります。 

 

プロパティの詳細 
 

アタックレベル：レベルは dB単位で-92 から 0 まで変化します。録音の開始点のラウドネスの 

レベルは、非無音検出のレベルです。 

アタック時間：時間はミリ秒単位で録音開始点のサウンディング時間です。これは、非無音検出の 

時間です。 

リリースレベル：レベルは dB単位で-92 から 0 まで変化します。録音の終了点のラウドネスの 

レベルは、無音検出のレベルです。 

リリース時間：時間はミリ秒単位で録音の終了点の無音時間です。これは沈黙検出の時間です。 
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8. 使用方法 
 

8.1 録音クイックツアー 

 

Mp3 Audio Editor を使用すると、音楽カセット、LP、ビデオ、又はその他の音源のオーディオ録音をデ

ジタル化できます。その後、CD 書き込みソフトウェアを使用して CDに書き込むことができます。 

 

新しい録音は、ハードディスクの一時ファイルに保存されます。「Stop」ボタンをクリックすると、新し

い録音が自動的に作成されます。 

 

録音はとても簡単です。録音を成功させるには、以下の手順に従います。 

 

接続方法 
 

このページは、音源を PC に接続して使用を開始するのに役立ちます。当社のソフトウェアを使用

して、LP、カセット、テープ、ミニディスク、又はその他のサウンドキャリアの音楽をデジタル化

し、通常のホームオーディオセット、カセットで再生できます。 

プレーヤー、ミニディスクプレーヤー、テープデッキなど、これらのサウンドキャリアのいずれか

から録音するには、プレーヤーのオーディオ出力をコンピューターのオーディオ入力に接続する必

要があります。 

Mp3 Audio Editor を使用して、サウンドを CD、又は MP3に保存します。 

尚、両端に適切なプラグが付いたケーブルは、オーディオパーツを扱う家電店などで販売されてい

ます。 

 

コンピューターの音声入力 
 

 

 

ディスクトップコンピューターのオーディオ入力は、通常、背面パネルの 3.5mm ミニジャックで、

Line-In、又は Aux のラベルが付いており、スピーカーが同様のタイプのジャックに接続される場所

の近くにあります。 

 

 

ディスクトップコンピューター 
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ライン入力入力は、記号    でマークされている場合があります。これは、矢印が外側を指して

いる記号    でマークされているスピーカー出力と混同しないでください。 

接続されているプレーヤーから録音するには、通常、ミキサーウィンドウでLine-In、又はAuxiliary

という名前の音源を選択します。 

 

 

殆どのラップトップやノートブックコンピューターには、Mic（マイク）とマークされた 1/8 "ミニ

ジャック入力が 1 つしかなく、ヘッドホンを同様のタイプのジャックに接続できる場所の近くにあ

ります。 

接続されたプレーヤーから録音するには、通常、Mixer（ミキサー）画面で、Mic、又は Microphone

という名前の音源を選択します。 

 

ラップトップ、又はノートブックに Line-In、又は Aux 入力ジャックもある場合は、プレーヤーを

その入力に接続することをお勧めします。その場合、通常、ミキサーウィンドウで Line-In、又は

Auxiliary という名前の音源を選択します。 

 

コンピューターの入力に接続するプラグは、コンピューターのスピーカー用のプラグと同様に、ス

テレオ 3.5mm ミニプラグである必要があります。 

 

 

 

このステレオミニプラグには先端に 2 つのプラスチックリングがあります。 下図のような先端に

1 つのプラスチックリングしかないモノプラグと混同しないように注意してください。 

 

 

 

モノラルプラグを使用してプレーヤーをコンピューターに接続すると、通常、左チャンネルにのみ

音が入ります。 

 

ラップトップ、又はノートブックコンピューター 
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プレーヤーのオーディオ出力 
 

プレーヤーのオーディオ出力接続タイプは、プレーヤーの種類とモデルによって異なります。 

通常、Play-Out、Line-Out、Audio-Out、又は同様の表現でマークされています。 

 

・ DINコネクタ 

このタイプのコネクタは通常、この Uher テープデッキのように、ヨーロッパ製の古いオーディオ

機器に見られます。 

 

  

 

・ RCA コネクタ 

このタイプのコネクタは、殆どの場合、この JVCカセットデッキのような最新のオーディオ機器に

見られます。 

 

 

 

・ ミニジャックコネクタ 

このタイプのコネクタは、殆どの場合、この Sony のミニディスクプレーヤーのようなポータブル

プレーヤーに見られます。 
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ターンテーブルの接続（ビニールレコードプレーヤー） 
 

ビニールレコードから録音するには、ターンテーブルとコンピューターの間に（プリ）アンプを接

続する必要があります。ターンテーブル出力の信号強度は、殆どの場合、コンピューターに直接接

続するには弱すぎます。 

 

これは、たとえばテープやカセットデッキのテープに LP を録音する場合と同じです。Technics タ

ーンテーブルが接続されたこの Kenwood レシーバー/アンプのように、Phono入力と Rec-Out 出力が

ある場合、ホームオーディオセットにはプリアンプが組み込まれていま す。 

 

 
 

ターンテーブルからアンプへのアース線も忘れずに接続してください。このワイヤーは、ターンテ

ーブルの敏感なピックアップエレメントによって拾われるハム（低周波ノイズ）を排除します。 

 

オーディオセットにプリアンプが内蔵されていない場合、又は Rec-Out、Line-Out、Audio-Out出

力がない場合は、別のターンテーブルプリアンプを購入できます。これらは、オーディオ機器販

売店などで購入することができます。 

 

ヘッドホン、又はスピーカー出力しかない場合の対応 
 

ラジカセなどの一部のオーディオセットには、ヘッドホンやスピーカー以外のオーディオ出力コネ

クタがありません。 

これらの出力の信号強度は、殆どの場合、コンピューターの入力に必要な信号強度よりも高く、信

号強度はその出力のボリュームコントロール設定によって異なります。 

したがって、このような出力をコンピューターに接続するには、特別な注意が必要です。 

 

注： ヘッドホン、又はスピーカー出力をコンピューターに接続する前に、まずプレーヤーのボリュ

ームコントロールをゼロに設定してください。 
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・ ヘッドホン出力 

 

オーディオセットにヘッドホン出力コネクタがある場合は、スピーカー出力ではなく、ヘッドホン

出力コネクタを使用することをお勧めします。 

 

ヘッドホン出力のボリュームコントロールレベルを試して、どのレベルが最高の録音品質になるか

を確認する必要があります。ヘッドホンのボリュームコントロールは、ミキサーの録音ボリューム

コントロールと組み合わせて、最終結果を決定します。 

 

経験則として、録音ウィンドウの録音レベルのピークメーターは、最も大きなフラグメントの間、

黄色のゾーンにホバリングする必要があると言えます。 

これを実現するには、ミキサーウィンドウのボリュームコントロールをフルスケールの約 75％に設

定します。次に、録音レベルのピークメーターが黄色のゾーンに達するまで、ヘッドホン出力の音

量コントロールをゆっくりと慎重に上げます。 

 

ヘッドホンの出力音量を大きく設定しすぎると、ミキサーウィンドウで音量コントロールをどれだ

け低く設定しても、音が歪んでしまいます。 

 

・ スピーカー出力 

 

オーディオセットにスピーカー出力しかない場合は、これをコンピューターに接続するときに非常

に特別な注意を払う必要があります。 

このタイプの接続用の既製のケーブルは販売されていません。とにかくこの方法で接続したい場合

は、自分で配線を作成する必要があります。 

スピーカー出力は、比較的高い信号電圧レベルでスピーカーを駆動するように設計されています。

スピーカーの音量が高すぎると、これらの信号レベルがコンピューターの入力に対して高すぎる可

能性があります。 

 

注： これらの高い信号レベルは、コンピューターのオーディオ入力を損傷する可能性があります。 

 

最高の音質を得るには、ヘッドホン出力に接続する場合と同じ経験則が適用されます。 
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8.2 接続方法 

 

このページは、音源を PCに接続して、Mp3 Audio Editorの使用を開始し、サウンドを CD、又は MP3

に変換するのに役立ちます。 

 

当社のソフトウェアを使用して、LP、カセット、テープ、ミニディスク、又はその他のサウンドキ

ャリアの音楽をデジタル化し、通常のホームオーディオセット、カセットプレーヤー、ミニディス

クプレーヤー、テープデッキなどで再生できます。 

これらのサウンドキャリアのいずれかから録音するには、プレーヤーのオーディオ出力をコンピュ

ーターのオーディオ入力に接続する必要があります。 

 

両端に適切なプラグが付いたケーブルは、オーディオ専門店や家電店で販売されています。 

 

ソースを接続する 
 

例えば、音楽カセット、LP、又はビデオに音声をデジタル録音できるようにするには、ビデオレコ

ーダー、カセットプレーヤー、レコードプレーヤーをコンピューターのサウンドカードに接続する

必要があります。 

サウンドカードはそれぞれ詳細が異なるため、ここでは、これを行う方法に関する一般的なガイド

ラインのみを提供します。 

 

・ 一般的なガイドライン 

 

カセットプレーヤーやビデオレコーダーは通常、ライン入力、又は補助入力コネクタを介してサウ

ンドカードに直接接続できます。カセットプレーヤーでは、出力、又は再生出力コネクタをサウン

ドカードに接続する必要があります。 

 

ビデオレコーダーでは、オーディオ出力コネクタ（ステレオ）をサウンドカードに接続する必要が

あります。オーディオ出力信号は通常、ビデオレコーダーのいわゆる SCART出力コネクタでビデオ

出力信号と一緒に利用できます。特別なケーブルは、小売店で入手できます。 

 

レコードプレーヤーの信号は通常、サウンドカードに直接接続するには弱すぎるため、プリアンプ

を介してサウンドカードのライン入力、又は補助入力コネクタに接続する必要があります。 

レコードプレーヤーをプリアンプに接続し、アンプをサウンドカードに接続します。 

通常、サウンドカードへの接続にはアンプの RecOut 出力コネクタを使用できます。 

 

レコードプレーヤーをサウンドカードのマイク入力に接続しないでください。サウンドカードのマ

イク接続は通常ステレオではなくモノラルであり、サウンドカードのマイクチャンネルはマイク以

外のソース用に設計されていないため、信号が歪む可能性があります。 
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Mixer（ミキサー）画面の「音源」で、サウンドカードのどの入力を録音するかを選択します。 

通常、これは、接続されたビデオレコーダー、カセットプレーヤー、レコードプレーヤーを録音す

るための Auxiliary（補助）又は Line In（ライン入力）です。 

もちろん、マイクなどの他のソースから録音することもできます。サウンドカードには、使用可能

な音源の種類と名前が記載されており、これはサウンドカードごとに異なります。録音している内

容は、サウンドカードに接続されているコンピューターのスピーカーから聞くことができます。 

 

音量の設定 
 

カセットレコーダーでの録音と同じように、録音音量を調整する必要があります。 

 

1. 音源がサウンドカードに正しく接続されていること、及び正しい音源が選択されていることを確認

します。 

2. スピーカーのスイッチがオンになっていて、音量が開いていることを確認します。 

3. ビデオレコーダー、カセットプレーヤー、レコードプレーヤーで、録音する曲の大きな断片を再生

します。ピークメーター（録音ウィンドウの右側にあります）がレッドゾーンに殆ど到達しないよ

うに、Mixer Settings（ミキサー設定）- Recording Source（録音ソース）画面で音量を調整しま

す。最も音量の大きいフラグメントの間、ピークメーターは、デジタル CDソースなどの一部の音源

にボリュームコントロールがないため、ボリュームコントロールが無効になります。その後、音量

は自動的に正しいレベルになります。 

一部のサウンドカードは、左右のサウンドチャネルボリュームの個別の制御をサポートしていませ

ん。ステレオ音質を選択した場合、これは必ずしも録音がステレオになることを意味するわけでは

ありません。 

 

録音 
 

録音中は、サウンドの開始と終了の瞬間に必ずしも注意を払う必要はありません。後でオーディオ

エディターを使用して、長すぎる開始やポーズを簡単にカットしたり、録音を複数のトラックにカ

ットしたりできます。 

 

1. 録音したい曲の先頭で、ビデオレコーダー、カセットプレーヤー、又はレコードプレーヤーをスタ

ンバイ状態にします。 

2. 最初に、レコーダーの赤い録音ボタンをクリックして、録音を開始します。 

3. 次に、ビデオレコーダー、カセットプレーヤー、レコードプレーヤーで曲の再生を開始します。 

4. 録音中は、ピークメーターがレッドゾーンに到達する頻度や長さが長すぎないように注意してくだ

さい。 

5. 曲が終了したら、サウンドレコーダーウィンドウの停止ボタンをクリックします。例えば、録音が

拍手で終わった場合は、この拍手の大部分も録音します。後で、オーディオエディターを使用して

簡単にフェードアウトできます。 



25 

 

 

録音が開始されると、録音をリセットして最初からやり直すために使用できるボタンが表示されま

す。新しい録音は、ハードディスクの一時ファイルに保存されます。Keep button（保持ボタン）を

クリックして録音を停止すると、新しい録音が自動的に作成されます。 

 

インターネットブロードキャストの録音（オーディオのストリーミング） 
 

サウンドレコーダーを使用すると、例えばインターネットラジオ放送（ストリーミングオーディオ）な

ど、コンピューターのスピーカーから聞こえるほぼすべての音源から録音できます。次の手順に従って

ください。 

 

1. まず、RealPlayerなど、使用しているプレーヤーでインターネットブロードキャストの再生を開始

します。 

2. RealPlayerが再生を開始するのを待ちます。再生を開始する前に、数秒のサウンドをダウンロード

します。 

3. 次に、サウンドレコーダーを起動し、適切な音源を選択します。音源の名前はシステムごとに異な

りますが、RealAudioの再生を録音するための音源は、通常、Wave、Stereo Mix、What You Hear、

又は同様の言葉で呼ばれます。サウンドレコーダーは、適切な録音品質を自動的に選択します。 

4. サウンドレコーダーで録音を開始します。オプションで、RealPlayerで再生を再開して、サウンド

クリップ全体を最初から録音することができます。 

 

ライブパフォーマンスの録音 
 

サウンドレコーダーを使用すると、ライブパフォーマンスを録音することもできます。ここにはい

くつかのオプションがあります。 

 

1. マイクをコンピューター、又はラップトップのマイク入力に接続し、マイク、又はマイクの音源か

ら直接ライブパフォーマンスを録音します。多くのコンピューターでは、マイク入力はステレオで

はなくモノラルであるため、ステレオマイク、（又はアダプタープラグ付きの 2 つの別々のマイク）

を接続すると、録音はモノラルでのみ行われることに注意してください。マイク、又はマイクの音

源を選択したときに、サウンドレコーダーウィンドウに 2 つの別々のボリュームスライダーが表示

されている場合は、ステレオで録音できます。 

2. 外部サウンドシステム、又は PA の Line-Out 出力をコンピューターの Line-In、又は Aux 入力に接

続し、Line-In、Aux、又は Auxiliary 音源から録音します。もちろん、これは、劇場やコンサート

ホールなど、何らかのサウンドシステムがすでに導入されている複雑なパフォーマンスに最も適し

ています。 

3. カセット、テープ、又はミニディスクレコーダーなどの他の従来の機器を使用してライブパフォー

マンスを録音します。後でこれらの録音は、カセット、テープ、ミニディスクプレーヤーをコンピ

ューターの Line-In、又は Aux 入力に接続し、Line-In、Aux、又は Auxiliary音源から録音すること

でコンピューターに転送できます。 
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トラブルシューティング 
 

録音に問題がある場合は、Settings（設定）の下にある「行ごとに使用できる」オプションを試してく

ださい。様々なサウンドカードには様々なオプションがありますので、時々実験する必要があります。

歪みの問題については、使用している録音ラインの音量を手動で変更する必要があります。現状は次の

とおりです。 

 

サウンドレコーダーを開く： 

次に、「Windows Sound Mixer の設定」をクリックします。 Windows サウンドミキサーが表示されます。 

Audio（オーディオ）タブをクリックします。サウンドミキサーは次のように表示されます。 

 

 

 

録音中で、音量ボタンをクリックします。 （これが音声再生中のボリュームボタンではないことを確認

してください）録音ウィンドウが表示されます。 
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使用している録音ラインの音量を下げてみてください。 

注: ステレオミックス、ウェーブアウトミックス、又はその他の可能性のあるオプションが表示されな

い場合は、メニューから「オプション」、「プロパティ」を選択します。録画デバイスの完全な一覧が次

のように表示されます。 

 

 

利用可能なすべてのデバイスがチェックされていることを確認してから、適切なものを選択できます。 

最良の音量レベルを得るためにいくつかのサウンドカードを試してみる必要があるかもしれません。 

 

Mono Mix： Mono モードでパソコンに接続されているプログラムプレーヤー、又はハードウェアチ 

ューナーから音を録音することができます。 

Stereo Mix： パソコンから接続されているプログラムプレーヤー、又はハードウェアチューナーか

らの音をステレオモードで録音できます。 

SPDIF：  コンピューターサウンドカードのデジタル入力ジャックに接続されている外部デバ

イスからサウンドを録音できます。 

AUX：  コンピューターサウンドカードの AUX（補助）入力に接続されている外部デバイスか

ら音声を録音できます。 

CDプレーヤー： コンピューターの CD/DVDROMドライブのレーザーオーディオディスクから音を録音す

ることができます。 

LINE IN： コンピューターサウンドカードの入力内の行に接続されている外部デバイスから音

を録音することができます。 

Microphone： コンピューターサウンドカードのマイク入力に接続されているマイクロフォンから

音を録音することができます。 

電話回線： コンピューターサウンドカードの電話回線入力に接続されている外部デバイスから

音声を録音できます。 
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8.3 CD からのオーディオトラックのインポート 

 

殆どの CD-ROMリーダーでオーディオ CDからオーディオデータをデジタルインポートすることができま

す。 

1 つ以上のオーディオトラックをインポートするには： 

1. 「ファイル」ニューから「オーディオ CD ...からトラックのインポート」を選択します。CD トラッ

ク抽出ダイアログボックスが表示されます。 

2. CD-ROMデバイスドロップダウンリストからソースオーディオ CDを含むデバイスを選択します。 

3. トラックリストからインポートしたいトラック、又はトラックを選択します。 

4. Load（読み込み）表示されたボタンをクリックします。 

インポートされたオーディオトラックは、Mp3 Audio Editorのワークスペース内の別々の編集ウィンド

ウとして表示されます。 
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8.4 基本音声編集 

 

この章では、ファイルの読み込みや保存やクリップボードの使用やドラッグアンドドロップなど、Mp3 

Audio Editor の基本的なオーディオ編集機能について説明します。 

 

Mp3 Audio Editor のワークスペース 
 

Mp3 Audio Editorワークスペースには、いくつかのオーディオ編集ウィンドウ、CDプロジェクト、又

はウィザードプロジェクトのクリーニングを含めることができます。 

 

上の図は、オーディオ編集ウィンドウを備えた Mp3 Audio Editorのワークスペースを示しています。

赤い矢印で示された要素については以下に説明されています。 

 

1. 一般的に使用されるコマンドのための短いカットアイコンを持つメインツールバーです。 

2. オーディオファイル「Beethoven.wma」を含むオーディオ編集ウィンドウです。オーディオは、録音

されたオーディオに対応する曲線で視覚化されます。（時間領域を参照） 

 

・ 時間領域 

Mp3 Audio Editor で録音を行うときに示される通常の波プロットは、信号の時間領域表現です。 

録音すると、Mp3 Audio Editor は一定の間隔で信号のサンプルを撮影し、それらを量子化し、 

それらを一連のデジタル化された値として保存しています。波プロットは、水平軸に沿って進化する 

時間でこれらのサンプルをスクリーン上に描画した結果です。 
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3. 白い背景の上の黄色い曲線で示された選択された領域（システム設定によって異なります）。現在の

カーソル位置は点滅ラインで示されています。 

4. クイックコマンドバー。オーディオデータで様々な操作を実行できます。 

5. 領域の一覧ウィンドウです。 

6. 時間領域です。 

7. 録音、再生、カーソルの位置付けのナビゲーションツールバーです。 

8. 選択された領域、視聴領域、及びカーソル位置を示すバーです。処理中は、ステータスバーに進行

状況が表示されます。 

9. 出力レベルメーターは、オーディオ再生中の現在の出力レベルを示します。 

 

オーディオファイルの読み込み 
 

・ 既存のオーディオファイルを開くには： 

1. 「ファイル」メニューから「Open」を選択します。 

2. ファイルがドロップダウンリストから表示されているフォルダを選択します。 

3. 開くオーディオファイルをクリックして、「OK」というラベルの付いたボタンをクリックします。 

 

オーディオファイルの保存 
 

・ 編集したオーディオファイルを元の名前で保存するには： 

 

1. 「ファイル」メニューから「保存」又は「Ctrl + S」キーを押します。 

 

音声編集ウィンドウの内容を別の名前で、別のフォルダ内、又は異なる設定で保存したい場合は、次の

手順を実行します。 

 

1. 「ファイル」メニューから「保存」を選択します。 

2. Look ドロップダウンリストからファイルを保存したいフォルダを選択します。 

3. オーディオファイルの名前を入力します。 

4. ファイルの種類ドロップダウンリストからオーディオファイルのファイル形式を選択します。 

5. 殆どのエクスポートフィルタは、符号化ビットレート、又は数値フォーマットなどの様々な設定を

提供します。 

 

録音をする 
 

録音の選択された領域を再生するには： 

1. コントロールメニューから「再生」又は「スペースバー」を押します。 

2. コントロールメニューから「コマンドの停止」又は「スペースバー」を押して選択して、再生を停

止できます。 
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完全な録音を再生するには： 

1. コントロールメニューから選択コマンドを再生するか、スペースバーを押しながら Shift キーを押

したままにします。 

2. コントロールメニューから「コマンドの停止」又は「スペースバー」を押して選択して、再生を停

止できます。 

 

選択した領域をループとして再生するには： 

1. コントロールメニューから「再生」 コマンドを選択します。 

2. コントロールメニューから「コマンドの停止」又は「スペースバー」を押し選択して再生を停止で

きます。或いは、便利な再生のためにナビゲーションツールバーを使用することもできます。 

 

領域の選択 
 

Mp3 Audio Editor は、選択された領域と選択されたチャンネルのすべての処理を行います。選択された

領域が強調表示されます。 

 

選択した領域を変更するには： 

1. 選択したい地域の先頭をクリックしてマウスボタンを押し続けます。 

2. マウスカーソルを選択したい領域の末尾にマウスカーソルを移動します。 

3. マウスボタンを放します。 

4. 新しく選択された地域は強調表示されるべきです。 

 

チャンネルの選択 
 

Mp3 Audio Editor は、選択された領域と選択されたチャンネルでのみ処理を行います。選択したチャン

ネル、又はチャンネルを変更（Stereo Recordingsでのみ可能）するには： 

 

1. ポインタが   又は   に変更されたときにアクティブにしたいチャンネルをクリックします。 
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8.5 波形編集インタフェース 

 

波形表示 

 

 

波形表示は、オーディオ素材を見る領域です。データを選択するための波形表示には多くのマウス操作

があります。 

 

波形の任意の場所を左クリックし、再生カーソルの位置を変更します。 

ステレオ波形を使用すると、波形表示の上部、又は下部にマウスポインタを置きます。（カーソルは、L

又は R 文字を取得）左クリックで編集に左右のチャンネルのみを有効にします。（無効なチャンネルは

レイアウトされます）無効なチャネルをもう一度左クリックして再度有効にします。 

 

波形表示を左クリックしドラッグして選択します。 

波形表示で左クリックして波形の可視部分全体を選択します。(ズームすると右、又は左に表示される

可能性のある非表示領域は選択されません) 

 

右クリックして、選択範囲を作成、延長、又は短縮します。 

選択範囲は、現在選択されている範囲を指定したポイントまで延長、又は短縮するか、或いは既存の選

択範囲がない場合は、カーソル位置から切り離します。 

 

表示範囲バー 
 

 

波形表示ウィンドウの上部の緑色表示範囲バー波形全体のどの部分が波形表示で表示されているかを

示します。ズームアウト、又はズームアウトすると、このバーは波形、又はセッション全体に関して表

示されている部分が変化するため、小さくても大きくなります。 

 

左クリックしてバーの緑色の部分をドラッグして、時間内に前後にスクロールします。 

タイムルーラーのドラッグと同様に、ズームレベルは保持され、視聴範囲のみが変更されます。 
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振幅定規 
 

振幅定規（Amplitude Ruler）は、オーディオデータの相対量を測定します。 

波形ビューでは、定規の表示形式は、サンプル（データの正確なサンプル値）、

デシベル、又は正規化値として（-100～100）のいずれかに設定できます。 

 

振幅定規を右クリックして、フォーマットを設定し、振幅定規を表示、又は非

表示にします。 

 

 

 

 

 

タイムルーラー（Time Ruler） 
 

 

 

タイムルーラー波形表示の任意の時点で現在位置を表示します。 

タイムマーキングは、ズームインされたときにより詳細に細分され、ズームアウトされたときに細部が

少なくなります。 

タイムルーラーを右クリックして、タイムルーラーフォーマット（10 進数、又はサンプル）を設定し、

タイムルーラーを表示、又は非表示にします。 

 

ズーミングとスクロール 
 

編集ウィンドウでより詳細なビューを取得するには、ズームインできます。水平方向にズームして、録

音の小さな部分を順番に表示して、より小さな振幅範囲を表示できます。 

 

水平ズーム 

 

水平にズームインするには： 

 

マウスホイールを下に動かすか、「表示メニュー」    をクリックします。 

 

 

注：     を選択することで、縮小してレコーディング全体を表示できます> 
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スクロール 

 

録音の一部のみが示されている場合、波形の視覚化にはスクロールバーが見えます。スクロールバーを

使用して録音の他の部分を表示できます。 

 

              又は  

 

マウスの操作 
 

マウスの左クリック: 

 

 

 

1. マーカーの領域(カーソルは目盛)で、マーカーの近くにあります。次に、選択領域は、

マーカーに応じて設定されます。 

 

マーカーが任意の領域を選択した場合、選択領域もマーカーに従って設定されます。 

 

 

 

 

 

2. ステレオチャンネルエリア(カーソルは L、又は Rを表示)です。 

 

ステレオチャンネルの 1 つが選択され、すべての操作が別のチャンネルに影響を与え

ません。尚、モノラルファイルでは機能しません。 

 

 

3. 任意の波形領域で。現在位置が変わります。 

 

マウスの左クリック： 

 

1. カーソルが現在のマーカー位置付近に位置する場合、現在のマーカー位置が追加され、そうでなけ

れば、現在のカーソル位置がマーカー位置のように追加されます。 

2. カーソルがマーカーを指し、マーカーは削除されます。 

3. メインエディターウィンドウをダブルクリックすると領域全体が選択されます。 
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マウスの右クリック 

 

1. 任意の波形領域で、現在の領域が選択されます。 最も近い境界は現在のカーソル位置に移動します。 

2. ステレオチャンネルエリア(カーソルは、L、又は R を表示)で、ステレオチャンネルの 1 つが選択さ

れます。すべての操作が別のチャンネルに影響を与えません。尚、モノラルファイルでは機能しま

せん。 

 

マウスの左ボタンをクランプしてマウスを移動 

 

1. 任意の波形領域で、現在の位置が選択されます。初期の詳細領域の境界付近でカーソルの種類が変

更され、ユーザーは現在の詳細領域の寸法を減らすか増やすことができます。 

2. ステレオチャンネルエリア(カーソルは L、又は R を表示)で、ステレオチャンネルの 1 つが選択さ

れ、すべての操作が別のチャンネルに影響を与えません。尚、モノラルファイルでは機能しません。 

3. ズーム領域で、ズームイン動作が以前に使用されている場合は、波形がロールされます。 

 

 

 

 

クリップボードを使用した編集 
 

クリップボードの概念は、すべての Windows アプリケーションの文書を編集する一般的な方法を提供し

ます。コマンド編集を使用して、選択した領域を Mp3 Audio Editor のクリップボードにコピーして録

音を編集できます。編集コマンドを使用して、選択した領域を別の場所にコピー＆ペーストします。 

貼り付けコマンドは、殆どのウィンドウアプリケーションで一般的な通常の仮付コマンドと同じです。 

Mp3 Audio Editor では、2 つの追加の貼り付け方法があります。 

 

・ 貼り付け上書き（Paste Overwrite）：クリップボードの内容で選択した領域を置き換えます。 

・ ペーストミックス（Paste Mix）：選択した領域をクリップボードの内容に混在させます。 

 

コマンド編集： 「切り取り」コマンドを使用すると、選択した領域をコピーしてから、ソース記録から

削除します。記録の一部を削除する目的で、次の 2 つのコマンドのいずれかを使用します。 

 

・ 削除（Delete）：  選択した領域を削除します 

・ トリミング（Crop）： 選択した領域以外のすべてを削除します。 
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ブックマークと領域の操作 
 

ラベルや領域などのアンカーを録音に挿入することで、編集プロセスを簡略化できます。 

 

ラベルの追加 

録音にラベルを追加するには: 

1. カーソル位置を ラベルを挿入する位置に移動します。 

2. マウスの右ボタンをクリックし、Add Bookmarks...（ブックマークを追加..）を選択します。 

3. カーソル位置にラベルが表示されます。 

 

リージョン（領域）マーカーの追加 

録音にリージョンマーカーを追加するには: 

1. リージョンマーカーを設定する録音部分を選択します。 

2. マウスの右ボタンをクリックし、Add Region...（リージョンを追加..）を選択します。 

3. 選択範囲に領域が表示されます。 

 

アンカーの名前変更、移動、削除 

アンカーの名前を変更するには： 

1. アンカーテキストを右クリックし、名前の変更を選択します。 

2. プロパティダイアログボックスが表示されます。 

3. アンカーの新しい名前を入力します。 

4. 「OK」 というラベルの付いたボタンをクリックします。 

 

アンカーを移動するには： 

1. アンカーを視覚化する赤い線の上部にあるマウスの左ボタンをクリックします。 

2. アンカーを新しい位置に移動しながら、マウスボタンを下にします。 

3. マウスボタンを放します。 

 

アンカーを削除するには: 

1. アンカーテキストを右クリックし、名前の変更を選択します。 

2. コンテキストメニューが表示されます。 

3. 「削除」を選択します。 

 

ラベルと領域の一覧ウィンドウ 

地域リストとラベルリストウィンドウを表示することで、アンカーを編集して追跡することができます。

ラベルリストウィンドウを表示するには、「表示」 メニューの「ブックマークリスト」 を選択します。

同じメニューのメニュー項目「領域リスト」は、領域リストを表示します。 

 

 



37 

 

 

9. 編集 
 

選択した領域 

 

以下の編集機能の多くは、選択した領域に適用されます。選択した領域をマークするには、Wave ウィン

ドウをクリックして押したままマウスをドラッグするか、Shift キーを押しながらファイル内を移動し

ます。ファイル全体を選択するには、Ctrl + A キーを押します。 

 

Undo（取り消し） 

 

Undo は、編集を行った後、編集前の状態にファイルを復元する機能です。編集を試したり、間違いを起

こしたりした場合に便利な機能です。 

操作を直前の状態に戻すには、Ctrl+ Z キーを押します。 

 

Cut（切り取り） 

 

Cut は、選択した領域を削除しますが、それをどこか別の場所に貼り付けることができるようにクリッ

プボードにコピーを保持することです。これは、ファイル内でオーディオの一部を移動する場合に便利

です。切り取り領域を選択し、Ctrl + X キーを押します。 

 

Copy（コピー） 

 

Copy は、選択した領域のコピーをクリップボードにコピーすることで、別の場所に貼り付けることがで

きます。これは、オーディオの一部を複製し、別のファイルに挿入（又はミックス）を重複したい場合

に便利です。 

コピーする領域を選択してから Ctrl + C を押します。ファイル全体をコピーするには Ctrl + A を押し

てから Ctrl + Cを押します。 

 

Paste（貼り付け） 

 

Paste は、Cut（切り取り）、又は Copy（コピー）機能を使用して選択した領域をクリップボードに移動

した後にのみ使用できます。 

Paste 機能は、現在選択されている領域を置き換えます 。(或いは、選択されていない場合は挿入され

ます) 

選択を置き換えるには、Ctrl + V キーを押します。挿入するには、位置をクリックして Ctrl + Vキー

を押します。 
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Paste Mix（ペーストミックス） 

 

この機能は、以前にコピー、又は切り取ったオーディオを取り込み、現在選択されているリージョンと

ミックスします。 

ミックスしたいオーディオをカット、又はコピーした後、新しいリージョンを選択し、メニューから Edit 

→ Paste Mix（編集→ペーストミックス）を使用します。 

ミックスのボリューム（volume of the clipboard audio ）を指定できます。 

 

殆どの場合、選択した領域の長さは異なります。(クリップボード内の)ミックスの選択が現在の選択範

囲よりも短い場合、ミックスされたオーディオは終了時に終了します。ミックスクリップボードが現在

の選択よりも長い場合は、フォローの 1 つを選択できます。Increase selection（選択範囲を増やす）

とは、ミックスファイルが終了するまでミックスが終了するまで継続することを意味します。 

Insert Silence（無音を挿入）とは、現在の選択範囲の最後に、ミックスが終了するまで挿入されるこ

とを意味します。 

フェードアウトミックスは、現在の選択の終わりがアプローチであるようにミックスがフェードアウト

することを意味します。これはバックグラウンドミュージックベッドや sfxに便利です。 

 

ペーストミックスの典型的な例は、ボイスオーバーの背後にある音楽ベッドをミックスしたい場所です。

1 つのファイルから音楽トラックをコピーするには、音声ファイルを開き、音声を選択 (Ctrl + Aを使

用)し、Edit → Paste Mix と fade out mix を選択します。 

 

Delete（削除） 

 

選択した領域を削除するには、Delete キーを押します。これはカット機能と似ていますが、選択した領

域はクリップボードに移動しません。 

 

Select All（全てを選択） 

 

ファイル全体を選択するには、Ctrl + A キーを押します。 

 

Select To Start（開始位置を選択） 

 

開始位置から現在位置までを選択するには、Shift + Homeキーを押します。 

 

Select To End（終了位置を選択） 

 

現在位置から終了位置までを選択するには、Shift + End キーを押します。 

 

 



39 

 

 

Select Specified Time（指定した時間を選択） 

 

正確な開始位置と終了位置を持つオーディオを選択する場合は、このオプションを使用します。 

Ctrl + G キーを押し、開始位置と終了位置を入力して 「OK] をクリックします。 

Preview（プレビュー） ボタンをクリックして、選択をプレビューすることもできます。 

 

Mix File（ミックスファイル） 

 

これは、最初にオーディオをクリップボードにコピーする代わりに、ミックスするファイルを指定する

という点を除いて、Paste Mix (前記)と同じです。 

 

Repeat Loop（繰り返しループ） 

 

この機能は、選択を何度も繰り返します。(音楽ベッドの長さを伸ばすのに便利です) 

繰り返したいリージョンを選択し menu Edit → Repeat Loop を使用してループする回数を入力します。 

 

Trim（トリム） 

 

Trim は、選択した領域だけが残るように、ファイルの先頭と末尾を切り取る方法です。 

これは、ファイルを録音した直後で、無音やノイズが存在する場合に便利です。 

 

Trim Start（トリム開始） 

 

現在の位置より前の項目をすべて削除（開始位置を指定）するには、 Edit → Trim Start選択します。 

 

Trim End（トリム終わり） 

 

現在の位置の後のすべてを削除（最後尾を指定）するには、Edit → Trim End を選択します。 

 

Split into two at this point（この時点で 2 つに分割） 

 

現在のファイルを 2つの小さなトラックに素早く分割する場合は、このオプションを使用します。 

これを行うには、先ず分割する位置をクリックし、この時点で、Edit → Split into two at this point

を選択します。元に戻すことができないので、これを行う場合は注意してください。 

 

Silence Select Region（無音選択領域） 

 

この機能は、選択した領域を消音します。これは、単語のタイミングを変更することなく、音声録音か

ら呼吸やクリック音を削除するのに便利です。 



40 

 

 

Save Select Region As（選択した領域を保存） 

 

この機能は、選択した領域を保存します。これは、編集した部分を素早く保存するのに便利です。 

 

Insert Silence（無音を挿入） 

 

メニュー項目 Edit → Insert Silence は、選択した位置、又は選択した位置に指定した区間の無音を

挿入するために使用されます。 

 

Insert File（ファイルの挿入） 

 

メニュー項目 Edit → Insert File は、選択した場所、又は選択範囲上に特定のオーディオファイルを

挿入するために使用されます。 

 

Copy To New（新規にコピー） 

 

現在のファイルの選択された部分に新しいファイルを作成するには、領域を選択してからメニュー 

Edit → Copy To Newを使用します。 
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10. 効果 
 

選択した領域 

 

以下に説明するすべての効果は、選択した領域にのみ適用されます。選択した領域をマークするには、

Wave ウィンドウをクリックして押したままマウスをドラッグするか、Shiftキーを押しながらファイル

内を移動します。ファイル全体を選択するには、Ctrl+ A キーを押します。エフェクトにアクセスする

ときに選択したリージョンがない場合は、波形全体がデフォルトとして選択されます。 

 

プリセット 

 

いくつかの効果は、Presets（プリセット）として知られている一連のオプションが付属しています。 

プリセットの背後にある考え方は、数字が多くの意味を持っていない場合に有効です。代わりに、プリ

セットリストを閲覧して、達成しようとしている効果を最もよく表すオプションを選択するできます。 

 

Amplify（増幅） 

 

Amplify（増幅）することは、選択された領域のラウドネス、又はボリュームを増大させることです。 

録音の一部を柔らかくするか、大きくするには、それを選択してからメニューエフェクト→ Amplifyを

使用します。ボリュームは、パーセント（100：変化なし、50：-6dB softer、又は 200：+ 6dB louder）

で入力されます。 

 

Normalize（規準化） 

 

Normalize（規準化）することは、最も大きいピークがデジタルオーディオで使用できる最大信号に等し

くなるようにボリュームを調整することです。通常、プロダクションの最後の段階としてファイルを

100％に正規化して、歪みなしに可能な限り最大限にします。 

 

High-Pass Filter（ハイパスフィルター） 

 

ハイパスフィルター（低カットフィルタとも呼ばれる）は、指定された Hz の下のすべての低周波数を

削除します。これは、録音サウンドを clearer（より鮮明）、又は Muddy（濁り）を作りたい場合に便利

です。了解度を向上させるために、すべての音声録音に約 300Hz のハイパスフィルターを使用すること

は非常に一般的です。 
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Equalizer（イコライザー） 

 

イコライザーは信号の周波数応答を変化させるので、色調の違いがあります。 

 

Effects（効果）メニュー → Equalizer（イコライザー）を選択した後、周波数に対する振幅のグラフ

が表示されます。スライダーバーを左クリックして新しいバンドポイントを作成します。 

 

必要な途中でイコライザーグラフを整形するのを支援するために、イコライザーグラフで使用される最

も一般的な種類のフィルターを表示するプリセットリストがあります。リストからプリセットフィルタ

を選択してから、必要な効果を得るためにフィルターを操作できます。 

 

単に周波数を下げるためにイコライザーを使用している場合は、常にハイパスフィルターを最初

（Effects menu → High Pass Filter）に試してください。それは、非常に低い周波数に対してより良

く速くなります。 

 

Echo（エコー） 

 

この機能を使用して、単一のエコーを作成し、他のいくつかの効果を作成できます。 

35 ミリ秒（MS）以上の遅延は離散エコーとして認識され、35～15 ミリ秒の範囲内に含まれているもの

は、単純なコーラスやフランジ効果を作成するために使用できます。これらの効果は、遅延設定が固定

され、時間の経過とともに変化しないので、実際のコーラスやフランジ効果ほど効果的ではありません。 

 

Reverb（復帰） 

 

Reverb（復帰）は、音に残響音や反射音を加えることで、空間的な深みや広がり感を出すエフェクトで

す。 たとえば小さなホールで演奏していても、大きなホールで演奏しているような残響感を演出する

ことができます。 

 

・ Duration（持続期間） 

The delay time： 遅延時間（ms） 

 

・ Mix Depth（ミックス深さ） 

Dry（ドライ）は入力信号の容積であり、Wet（ウェット）は遅延信号の容積、パーセントで、0～100

まで変化します。Mix Depth = 0の結果信号には遅延信号が含まれていません。Mix Depth = 100の

結果信号に入力信号が含まれていない場合、ミッコス深さの他の値は、Dry と Wet（wet = 100–dry）

の組み合わせです。 

 

・ Feed Back Gain（フィードバックゲイン） 

フィードバックは、入力にフィードバックされる遅延を設定します。 0～100まで変化します。 
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・ Reverb Gain（復帰ゲイン） 

dBの残響信号のレベルです。 

 

・ Tap Delay（タップディレイ） 

遅延前のタップ数は入力にフィードバックされます。 

 

・ Reverb Frequency（復帰周波数） 

トリムのタイプで、「左、右、又はトリムレベルの両側からのトリム」のいずれかのタイプにするこ

とができます。 

 

Reverse（リバース） 

 

この効果は、レコードやテープを逆向きに再生するのと同じ方法で選択を反転させます。 

 

Fade In（フェードイン）・Fade Out（フェードアウト）・Fade Out and Trim（フェードアウトしてトリ

ミング） 

 

フェードアウトオプションとトリムオプションは、選択範囲を表示する組み合わせ関数で、選択の終わ

りをファイルの末尾としてマークします。これは音楽トラックの終わりに頻繁に使用されます。 

 

Envelope（エンベロープ） 

 

Envelope （音量の変化曲線）は、時間の経過とともに選択領域のボリュームの変化です。これは、時間

の経過とともに体積を細かく調整するために使用することもできます。 

 

ボリュームを変更したいリージョンを選択し、メニュー Effects → Envelope を使用します。 

任意の点をクリックしてボリュームを調整してください。 

 

Speed Change（スピードチェンジ） 

 

通常の速度変化は、速度に比例してピッチを変化させます。速度を変更したいのであれば、ピッチを同

じ機能にしてください。 

 

Pitch Change（ピッチチェンジ） 

 

これにより、速度を変えずに録音のピッチが変わります。（即ち、上記の逆） 
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Dynamic Range Compressor（ダイナミックレンジコンプレッサー） 

 

ダイナミックレンジコンプレッサーは、サウンドレコーディングの音量レベルを制限して、あるラウド

ネス範囲内にあるようにします。 

それが使用されている場所の例はテレビ放送にあり、そこでは広告のボリュームレベルがテレビ番組自

体（実際のブロードキャストボリュームの変更なしに）よりも大きいものとして知覚されます。 

それは、又、ある媒体から別の媒体に音声を録音するための使用を有し、ここで 2 つの媒体は同じ範囲

のボリュームレベル（例えば、CD はカセットテープよりもはるかに大きい範囲）を処理することはでま

せん。Threshold（しきい値）設定は、音声録音ボリュームが定義されたデシベルレベルを超えたときに

検出することによって機能します。その後、音声を徐々に減衰させて dB レベルを下回り、リスナーは

減衰が発生していることを認識しません。 

 

Flanger（フランジャー） 

 

フランジャーとは、元の音声信号と、それを僅かに遅延させた音声信号の干渉により音を変化させるエ

フェクターです。フランジングは、遅延の長さが絶えず変化しているそれ自体のわずかに遅延コピーを

持つ信号をミキシングすることによって作成されます。 

 

・ Delay Rate（遅延率） 

遅延率： 0～100（遅れは 20ミリ秒）まで変化します。 

 

・ Mix Depth（ミックス深さ） 

Dry（ドライ）は入力信号の容積であり、Wet（ウェット）は遅延信号の容積、パーセントで、0～100

まで変化します。Mix Depth = 0の結果信号には遅延信号が含まれていません。Mix Depth = 100の

結果信号に入力信号が含まれていない場合、ミッコス深さの他の値は、Dry と Wet（wet = 100–dry）

の組み合わせです。 

 

・ Feed Back Gain（フィードバックゲイン） 

フィードバックは、入力にフィードバックされる遅延を設定します。 0～100まで変化します。 

 

・ Sweep Depth（スイープ深さ） 

スイープ深さは、掃引が遅延時間の面である幅がパーセントであるという幅を決定します。 0～100

（最大効果）まで変化します。 

 

・ Sweep Rate（スイープ率） 

このパラメーターは、フランジの周波数を表します。パーセントで 0～100 まで変化します。 

 

・ Sweep Phase（スイープフェーズ） 

ラジアンの遅延のフェーズです。 
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Chorus（コーラス） 

 

コーラスは、フランジャーとはいくつかの方法で違います。1 つの違いは、使用される遅延量です。 

コーラスの遅延時間は、フランジャー内のよりも大きく、通常は 20 ミリ秒～30 ミリ秒の間のどこかに

あります。（フランジャーの遅延は、通常 1ミリ秒から 10 ミリ秒）この長い遅延は、フランジャーの特

徴的な音を生み出しません。コーラスは、又、一般に使用されていないという点でフランジャーとは異

なります。 

 

11. Tools（ツール） 

 

Frequency Analysis（周波数分析） 
 

このツールは、ディスクリート高速フーリエ変換（DFFT）を使用して、波形の現在の選択された位置に

あるオーディオをその周波数成分に分離します。使用するには、分析したいオーディオのポイントに波

形カーソルを設定し、Tools  →  Frequency Analysis （周波数分析）を選択します。 

ウィンドウが開き、FFT グラフと呼ばれる 1 つ、又は 2つのグラフが表示されます。 

分析しているオーディオファイルがモノラルフォーマットの場合、1 つの青いグラフが表示されます。

ファイルがステレオの場合、左チャンネルに 1 つの青グラフと右チャンネルに 1つのピンクのグラフが

あります。 

 

右上の角は、マウスカーソルが現在位置しているグラフ内の点の周波数とデシベル値です。 

デシベル値は、上部の 0dB（最も大きい）から-127dB（Softest）までの範囲です。 

周波数範囲は、左側の 0Hz から右側のオーディオのサンプルレートの半分までの 0Hzの範囲のオーディ

オファイルのサンプルレートによって異なります。 

 

FFT グラフをより詳細に見るには、ウィンドウの下部、又は右側（これにより、それぞれグラフを水平

方向、又は垂直方向にズーム）に沿ってズームインボタンをクリックします。 

ズームインしている間、下側と右側の側面に沿ってスクロールバーを使用して水平方向、又は垂直方向

にスクロールできます。 

 

グラフをズームインするには、それぞれのズームアウトボタンをクリックするか、右下隅にあるボタン

をクリックして、ビューをフルスケールに戻します。 

 

ズームイン、及びズームアウトボタンを使用する代わりに、FFT グラフウィンドウのサイズを変更する

だけです。これを行うには、マウスカーソルをウィンドウのエッジ、又はコーナーに移動し、左マウス

ボタンを押しながらマウスを必要に応じて移動します。 
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Text To Speech (Speech Synthesis) 音声へのテキスト（音声合成） 
 

このツールを使用すると、入力したテキストからコンピューター生成された音声を作成できます。 

メニューTools → Text to Speech（スピーチへのテキスト）を使用します。 

テキストを入力（又は、Ctrl + Vでを貼り付け）、と Synthesize Speech（スピーチの合成）をクリック

します。それを正しく得るためには一部の試行錯誤が必要です。 

 

この機能には、コンピューターにスピーチエンジンがインストールされている必要があります。 

Microsoft Speech Engine（又は、外国語スピーチエンジン）をダウンロードするには www.Mp3 Audio 

Editor.comを参照してください。 

 

Batch Converter（バッチコンバーター） 
 

同じ方法で処理したいファイルが多数ある場合は、バッチコンバーターツール（Tools → Batch 

Converter）を使用してください。 

ファイルのリストを指定し、適用されるエフェクトのリストと Mp3 Audio Editorの一覧は、すべて batch

（バッチ）にします。 

 

12. Bookmarks and Regions（ブックマークと領域） 

 

Bookmarks（ブックマーク） 
 

ブックマークは、頻繁に戻りたいファイル内の位置です。例えば、ブックマークを使用して、録音され

たインタビューに興味深い部分の場所を保存することができます。 

 

ブックマークを追加するには、Ctrl + B を押して位置の名前を入力します。 

 

ブックマークに戻る場合は、Ctrl + Shift + B を押し、ブックマークリストを開くには、リストからブ

ックマークを選択して、右クリックメニューの Go to Bookmark （ブックマークに移動）を選択します。 

 

別のブックマークまで選択するには、リストからそのブックマークを選択してから、右クリックメニュ

ーの Bookmark option を選択します。 

 

ブックマーク（領域とは異なる）は実際のファイルにリンクされています。従って、Mp3 Audio Editor、

又はプロジェクトを閉じた後も持続します。 

 

ブックマークが不要な場合は、Ctrl+ Shift + B リストを使用してブックマークを削除する必要があり

ます。 

http://www.mp3audioeditor.com/
http://www.mp3audioeditor.com/
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Regions（領域） 
 

領域は、録音の選択された部分を保存します。(コピークリップボードに少し似ていますが、多くを持つ

ことができます) 

領域を追加するには、Ctrl + Rをクリックして名前を付けます。その後、任意の時点で、リージョンリ

スト（Ctrl + Shift + R）を開き、右クリックメニューを使用して、再生、選択、名前変更、削除、新

規コピー、又は領域の保存ができます。 

又、Export Region(s) to folder（領域をフォルダにエクスポート）を選択して選択した領域を 1 つの

フォルダにエクスポートすることもできます。 

領域は、再配置する必要があるインタビューのような長い録音で作業する場合に非常に便利です。 

 

13. Batch Converter（バッチコンバーター） 

 

バッチコンバーターは、同じ操作（エフェクト、又はコンバージョン）をファイルのリスト全体に適用

する場合に使用されます。 

 

メニューTools → Batch Converter を使用してバッチコンバーターを開きます。 

 

ステップ 1：ファイルを選択 

 

Add（追加）ボタンをクリックして、処理したいファイルを参照してください。 

選択しながらシフトキー、又はコントロールキーを押したままにして、複数のファイルを

同時に選択できます。すべてのファイルを追加したら、「Next」をクリックします。 

 

ステップ 2：コマンドを選択 

 

ファイルに適用するコマンドごとに、Add （追加）コマンドの選択をクリックし再度追加

をクリックします。リスト内の項目をドラッグしてコマンドを並べ替えることができます。 

 

ステップ 3：出力フォーマットとフォルダを選択 

 

デフォルトの Mp3 Audio Editor でファイルを保存します。但し、フォーマットを変換し

たい場合は Convert to file format（ファイル形式に変換）を選択してから拡張子を選択

してください。一部のファイル（例：WAV、又は MP3）には、フォーマットオプションを使

用して変更できる他のオプション bitrate or codec（ビットレート、又はコーデック）が

あります。 

注 ：サンプルレートを変更する場合は、aboveコマンドでサンプルレートの変換コメント

を使用します。 
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14. Mp3 Audio Editor Options（オプション） 

 

General Settings（一般設定） 
 

新しいファイルを作成するとき 

 

・ サンプルレートとチャンネルの入力 

 

新しいオーディオファイルを作成するときに Mp3 Audio Editor がサンプルレートとチャンネルの入

力を求めるようにする場合は、このオプションを選択します。 

 

・ デフォルトのサンプルレートとチャンネルを使用 

 

新しいオーディオファイルを作成するときにデフォルトのサンプルレートとチャンネルを使用する

場合は、このオプションを選択します。 

デフォルトのサンプルレートとチャンネルを変更するには、ボタン Set Default Sample Rate and 

Channels（デフォルトのサンプルレートとチャンネルを設定）をクリックします。サンプルレートは

1 秒あたり 600～96000 サンプルの間でなければなりません。 

 

Options（オプション） 

 

・ ファイルウィンドウを自動的に再配置して、それらがすべて表示されるようにする 

 

Mp3 Audio Editor を Mp3 Audio Editorにロードするたびに、Mp3 Audio Editor が Windows の水平

方向にすべてのファイルウィンドウを自動タイルする場合は、このオプションを選択します。これ

はいつでもすべてのファイルを表示できるようにしたい場合に便利です。 

 

・ Mp3 Audio Editor を Windows エクスプローラコンテキストメニューに追加する 

 

サポートされているすべてのオーディオファイルフォーマットについては、Windowsエクスプローラ

ーの右クリックコンテキストメニューに Mp3 Audio Editor を追加したい場合は、このオプションを

選択してください。たとえば、このオプションを選択して、Windowsエクスプローラーで.wav ファイ

ルを右クリックし、表示されるメニューの Edit with Mp3 Audio Editor（Mp3 Audio Editor で編集）

という項目を表示する必要があります。 
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Audio（オーディオ） 
 

Audio Working Folder（オーディオ作業フォルダ） 

 

Mp3 Audio Editor がファイルをロードすると、編集および処理のために作業フォルダ内の作業オーディ

オのコピー（全品質 32 ビット）を保持します。 Cドライブのハードドライブスペースを使い果たして

いる場合は、他の一時フォルダになるようにこれを変更できます。 

 

・ Play Options（オプションを再生） 

 

開くと自動的にファイルを再生します 

M Mp3 Audio Editor がオープン時にファイルを自動的に再生する場合は、このオプションを選択し

ます。 

自動再生編集、又はエフェクトの後の自動再生編集、又はエフェクト操作の実行が終了した後に Mp3 

Audio Editor を自動的に再生する場合は、このオプションを選択します。 

 

・ ブックマークに行ってから自動的にファイルを再生 

 

ブックマークを選択した後に Mp3 Audio Editor がファイルを自動的に再生する場合は、このオプシ

ョンを選択します。 

選択領域の後にファイルを自動的に再生する領域を選択した後に Mp3 Audio Editorがファイルを自

動的に再生する場合は、このオプションを選択します。 

巻き戻しと早送りで巻き戻し、又は早送り時に PLAY ボリュームを-8dB で縮小する場合は、このオプ

ションを選択します。 
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15. Mp3 Audio Editor Output Formats（出力フォーマット） 

 

Mp3 Audio Editor では、殆どのフォーマットで、特定の形式のオプションを設定できる設定ダイアログ

を保存できます。このダイアログは、File menu（ファイルメニュー）→ Save As （名前を付けて保存）

をクリックし、出力フォーマットを指定した後にのみ表示可能です。次のセクションでは、Mp3 Audio 

Editorで使用可能な様々な設定ダイアログの内容を詳しく説明します。 

 

15.1 WAV Settings（WAV 設定) 

 

ソフトウェアが Waveファイルを作成する 2 つの方法があります。 

 

・ CD Quality（CD 品質） 

 

これが最も人気のある設定です。カスタム CD コンパイル時にそれらを焼くことができるように WAV

ファイルを作成している場合は、このオプションを選択してください。それは、CD 品質のフォーマ

ットの WAV と MP3 ファイルが CD 品質の互換性のある WAV ファイルに変換されることを保証します。

CD品質フォーマット WAVファイルは 44,100 Hz、16 ビット、ステレオです。 

 

・ Specific Settings（特定の設定） 

 

Sample Rate（サンプルレート） 

 

サンプルレートは、1 秒あたりのサウンドポイント数です。たとえば、22,050 Hz は毎秒 22,050 サ

ンプルのサウンド データがあることを意味します。サンプルレートがリストにない場合は、サンプ

ルレートを入力することもできます。 

 

Mode（モード） 

 

ステレオは、結果のファイルが左右のチャンネルを持つことを意味します。モノラルとは、チャンネ

ルが 1つしかないということです。 

 

Bits Per Sample（サンプルあたりのビット数） 

 

各サンプルは、有限数のビットで保存されます。使用するビット数が多いほど、ノイズが少なくなり

ます。ただし、サンプルごとのビット数が多いほど、ファイルサイズも大きくなります。デフォルト

は 16 ビットです。8ビットの音は、特に微妙なダイナミックな音のために騒がしい音になることが

あります。 
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15.2 MP3 Settings（MP3 設定） 

 

Preset Quality（プリセット品質） 
 

MP3 ファイルの圧縮レベルを選択する最も簡単な方法は、プリセット品質スライダーを使用することで

す。 

 

プリセット品質スライダーを使用すると、いくつかのレベルの品質と結果のファイルサイズから選択で

きます。高品質を選択すると、ファイルサイズも上がります。一方、低品質のプリセットは、インター

ネットを介してより小さくてより簡単になります。 

 

プリセット ビットレート モード LAME 変換 

Phone 16 kbps Mono X 

Shortwave 24 kbps Mono X 

AM Radio 32 kbps Mono X 

FM Radio* 96 kbps Stereo X (J-stereo) 

Voice 64 kbps Mono X 

Radio 112 kbps Stereo  

Tape 128 kbps Stereo  

Hi-Fi 160 kbps Stereo  

CD 192 kbps Stereo  

Studio 256 kbps Stereo  

 

デフォルトは CD品質（192 kbps、ステレオ）です。 

 

* FM ラジオのビット レートは、次のプリセット品質 Voice(音声)よりも高くなることに注意してくだ

さい。音声は 64 kbps、FM ラジオは 96 kbpsです。 

不一致があるのは、音声がモノラルで FM ラジオがステレオだからです。FM ラジオのビット レートを

半分に分割する場合は、チャネルあたり 48 kbps の音声プリセットよりも低くなります。 
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15.3 OGG Settings（OGC 設定） 

 

これらのオプションを使用すると、OGGファイルのビットレートと品質を設定できます。 

 

Preset Quality（プリセット品質） 
 

この便利なスライダーを使用すると、様々な構成のリストからすばやく選択できます。 

 

プリセット ビットレート チャンネル 

音声品質 64 kbps Mono 

FM 品質 96 kbps Mono 

テープ品質 128 kbps Mono 

Hi-Fi 品質 160 kbps Mono 

CD 品質 192 kbps Mono 

スタジオ品質 256 kbps Mono 

最高品質 250 kbps Mono 

 

Specify Settings（設定を指定） 
 

これにより、特定のビットレート、チャネル、および平均、又は可変ビットレートを設定できます。 

 

・ Average Bit Rate（平均ビットレート）： 

平均ビットレートを設定するには、これを選択してください。 

・ Variable Bit Rate（可変ビットレート）： 

可変ビットレートを設定するにはこれを選択してください。 

スライダーを変更して品質を 1％から 100％に設定します。 

・ Mode（モード）： 

平均ビットレートモード、又は可変ビットレートモードでモノラル、又はステレオを

選択します。 
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15.4 WMA Settings（WMA 設定） 

 

WMA タブが表示されない場合は、WMA サポートが正しくインストールされていない可能性があり

ます。 

 

WMA は第 2 世代の圧縮オーディオフォーマットです。 
 

この画面のメインオプションは、スライダーを動かすことによって選択されている品質フォーマットで

す。設定可能な設定は次のとおりです。 

 

プリセット ビットレート モード 周波数 

1 16 kbps Mono 8,000 Hz 

2 32 kbps Stereo 8,000 Hz 

3 48 kbps Mono 44,100 Hz 

4 64 kbps Stereo 44,100 Hz 

5 96 kbps Stereo 44,100 Hz 

6 128 kbps Stereo 44,100 Hz (default) 
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